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PREFACE 

 
This guide describes how to use SteelVis and its associated programs.  SteelVis has two main functions: 

(1) to translate a CIS/2 (CIMsteel Integration Standards) file into an interactive 3D model in the form of a 

VRML (Virtual Reality Modeling Language) file that can be displayed in a web browser VRML plugin or 

VRML viewer and (2) to translate a CIS/2 file into an IFC (Industry Foundation Classes) file that can be 

imported into many BIM (Building Information Modeling) applications.  SteelVis also includes the CIS/2 

File Analyzer that converts a CIS/2 file into a spreadsheet that can be used for inspecting and debugging 

the attributes, values, and relationships in the CIS/2 file. 

 

SteelVis used to be known only as the CIS/2 to VRML and IFC Translator. 

 

More information about SteelVis, CIS/2, and IFC can be found at http://cic.nist.gov/vrml/cis2.html.  

 

DISCLAIMERS 

 
Any mention of commercial products in SteelVis and this user’s guide is for information purposes only; it 

does not imply recommendation or endorsement by NIST.  For any of the web links in SteelVis and this 

user’s guide, NIST does not necessarily endorse the views expressed, or concur with the facts presented 

on those web sites. 

 

This software was developed at the National Institute of Standards and Technology by employees of the 

Federal Government in the course of their official duties. Pursuant to Title 17 Section 105 of the United 

States Code this software is not subject to copyright protection and is in the public domain. This software 

is an experimental system. NIST assumes no responsibility whatsoever for its use by other parties, and 

makes no guarantees, expressed or implied, about its quality, reliability, or any other characteristic. 

 

Vendors of various software applications with CIS/2 export capabilities have supplied the sample CIS/2 

files.  The sample CIS/2 files do not necessarily reflect the current CIS/2 export capabilities of the 

software packages represented nor are all software packages that have implemented CIS/2 represented.  

NIST assumes no responsibility whatsoever for their use by other parties, and makes no guarantees, 

expressed or implied, about their quality, reliability, or any other characteristic. 

   

This software can be redistributed and/or modified freely provided that any derivative works bear some 

notice that they are derived from it, and any modified versions bear some notice that they have been 

modified.  We would appreciate acknowledgement if the software is used.  
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1 Introduction 
 

The CIMsteel Integration Standards (CIS/2) [1, 2] are the product model and electronic data exchange 

format for structural steel project information. CIS/2 is intended to enable a seamless and integrated flow 

of information among all parties of the steel supply chain involved in the design, analysis, engineering, 

fabrication, and construction of steel framed structures.  The CIS/2 standard covers everything from nuts 

and bolts to materials and loads to frames and assemblies.  Structures can be represented as design, 

analysis, or detailed models.  Detailed models are also known as manufacturing, physical, or fabrication 

models.  CIS/2 has been implemented as a file import and/or export capability in many steel design, 

analysis, engineering, fabrication, and construction software packages. 

 

Using SteelVis as a CIS/2 file viewer provides a way to visually verify the information in a CIS/2 file and 

to provide feedback about many of the attributes of the structural steel model.  To visualize a CIS/2 file, 

SteelVis generates a VRML (Virtual Reality Modeling Language) file [3, 4] which can be viewed in a 

web browser VRML plugin, VRML viewers, or other software that can display VRML files. 

 

Using SteelVis to translate a CIS/2 file into an Industry Foundation Classes (IFC) file [5] allows 

information about a steel structure to be imported into Building Information Modeling (BIM) software 

that can only import IFC files and not CIS/2 files.  The capability to import the CIS/2 model into BIM 

software allows for coordination between the structural steel model and other parts of the structure such 

as concrete and mechanical and electrical systems.  IFC is the product model and electronic data 

exchange format to facilitate interoperability between software applications in the building industry.  It is 

developed by buildingSMART [6], formerly known as the International Alliance for Interoperability. 

 

The CIS/2 to VRML Translator was first developed in 2000 as a command-line program that ran on a 

Silicon Graphics workstation.  In 2001, the web services version of the translator was made available 

online.  In 2003, the Windows version with a graphical user interface was developed.  In 2005, the 

capability to translate from a CIS/2 file to an IFC file was added to SteelVis.  This User’s Guide for 

SteelVis was written in 2011. 

 

2 Getting Started 

2.1 Installing SteelVis 

The download request form for SteelVis can be found at  

http://ciks.cbt.nist.gov/cgi-bin/ctv/ctv_request.cgi.  After submitting the download request, instructions 

about where to download SteelVis will be provided.  The information is also emailed to the requestor.  

SteelVis is downloaded as a zip file named CTV.zip.  The file is named CTV for CIS/2 To VRML. 

 

The installation process does not require anything more than unzipping the file CTV.zip.  This will 

create a directory named CTV containing six files: 

 

1. CIS2_VRML.exe – SteelVis graphical user interface (GUI) version 

2. ctv.exe – SteelVis command-line version, no GUI, (section 10 below) 

3. ctv-64.exe – Version of ctv.exe that runs only on 64-bit computers 

4. CIS2_Excel.exe – CIS/2 File Analyzer generates an Excel spreadsheet from a CIS/2 file, 

(section 8.3 below) 

5. SteelVis-README-FIRST.pdf – A brief introduction to SteelVis 

6. SteelVis-Users-Guide.pdf – This user’s guide 

 

http://ciks.cbt.nist.gov/cgi-bin/ctv/ctv_request.cgi
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There are no restrictions as to where the CTV directory is located in the computer’s file system, however, 

the four executable files and the User’s Guide in the CTV directory should not be moved from the 

directory. 

2.2 Running SteelVis 

SteelVis can run on any Windows 7, XP, or Vista computer.  There are no minimum system requirements 

for SteelVis although as with any computer program, more memory, a fast computer processor, and more 

graphics memory is better.  SteelVis (CIS2_VRML.exe) is a 32-bit application.  The size of the CIS/2 

file that can be translated by SteelVis depends on the amount of computer memory and SteelVis options 

selected.  CIS/2 files greater than approximately 200 MB might require using the 64-bit command-line 

version of SteelVis (ctv-64.exe) and a computer with more than 2 GB of memory. 

 

To run SteelVis, simply double click on the icon for CIS2_VRML.exe.  The first time SteelVis is run 

several setup functions are performed: 

 

1. The user is asked if a shortcut to SteelVis can be created in the Start Menu and if an icon for 

SteelVis can be placed on the Desktop.  The SteelVis icon is a cartoon representation of an I-

beam.  Creating the shortcut and icon facilitates running SteelVis without having to remember 

where it is installed.  A shortcut to SteelVis is also created in the CTV directory. 

2. If more than one web browser is installed on the computer, the user is asked to select the default 

web browser to use with SteelVis.  The selected web browser should be the web browser where a 

VRML plugin is already or will be installed.  This selection can be changed later in the Browsers 

menu of SteelVis (section 3.1.2 below).  SteelVis detects if the following web browsers are 

installed on the computer: Internet Explorer, Firefox, Google Chrome, Opera, and Safari. 

3. A welcome dialog is displayed that indicates that the VRML Plugin Detector will run after 

clicking OK.  The VRML Plugin Detector is described in section 2.3 below. 

4. A file SteelVis_options.dat is created in the user’s home directory that stores the current 

state of the SteelVis options.  Do not edit this file. 

 

Also, the first time SteelVis is run, two directories html and sample are created in the CTV directory 

and several utility and sample CIS/2 files are written to those directories.  The second time SteelVis is 

run, the Disclaimers dialog is displayed. 

 

The sample directory contains seven CIS/2 files: 

 

 cis2_analysis.stp – analysis model, display options are described in section 6.2 below 

 cis2_design.stp – design model, display option are described in section 6.3 below 

 cis2_detailed.stp – detailed model, shown in Figure 37 below, display options are described 

in section 6.1 below 

 cis2_curved.stp – detailed model of curved beams, see section 7.4 below 

 cis2ifc_test1.stp, cis2ifc_test2.stp – use to test IFC Shape Representation and 

Cardinal Point, (sections 9.1 and 9.6.5 below) 

 cis2ifc_test3.stp – all section types, see Figure 7 below 

 

The sample CIS/2 files can be used to understand and test: (1) various features of SteelVis, (2) how a 

VRML plugin or viewer displays a VRML model, (3) how a CIS/2 file is translated to an IFC file, and (4) 

how an IFC application imports and displays the IFC file. 
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2.3 Installing a VRML Plugin 

To visualize a CIS/2 file, SteelVis generates a VRML (Virtual Reality Modeling Language) file.  VRML 

is a standard file format that is used to display 3D models in a web browser VRML plugin or other 

VRML viewer.  Without a VRML plugin or viewer, the 3D interactive model of the CIS/2 file cannot be 

displayed. 

 

The VRML Plugin Detector runs in the web browser that was selected in step 2 above.  It determines 

which, if any, VRML plugin is installed in the web browser.  It does not detect other VRML viewers. A 

security warning might be displayed when running the VRML Plugin Detector in Internet Explorer.  In 

this case click on the warning and select “Allow Blocked Content…”.   

 

If a VRML plugin is installed, then a sample VRML model, which was generated from a CIS/2 file, is 

also displayed.  If a VRML plugin is not detected, then a list of VRML plugins that work with SteelVis is 

provided.  Currently, those VRML plugins are: 

 

 BS Contact - http://www.bitmanagement.com/en/products/interactive-3d-clients/bs-contact  

 Cortona3D Viewer - http://www.cortona3d.com/Products/Cortona-3D-Viewer.aspx 

 Cosmo Player – http://cic.nist.gov/vrml/cosmoplayer.html  

 Flux Player - http://mediamachines.wordpress.com/flux-player-and-flux-studio/  

 Octaga Player – http://octagavs.com/softwarem/octaga-player    

 

Select one of the VRML plugins and follow the instructions that come with the VRML plugin to install it 

in the web browser.  All of the VRML plugins can be installed in Internet Explorer and Firefox and some 

can also be installed in Google Chrome, Opera, and Safari.  Some of the VRML plugins will install in the 

64-bit version of Internet Explorer.  Although Cosmo Player is available from the NIST web site, it was 

not developed at NIST. 

 

A license is available for purchase with BS Contact, Cortona3D Viewer, and Octaga Player.  The license 

removes the product logo from the VRML browser window.  BS Contact, Flux Player, and Octaga Player 

also come with standalone VRML viewers that do not require a web browser to run in.  They can also be 

used by SteelVis to display VRML models (section 3.1.2 below). 

 

All of the VRML plugins have been tested to ensure that they work correctly with SteelVis.  The main 

difference between the VRML plugins is how the user interacts with the VRML model that is displayed.  

All of the VRML plugins allow the user to rotate, pan, and zoom the VRML model; however, each uses 

different functionality for the mouse buttons and menu items. 

2.4 Translating a CIS/2 File 

After a VRML plugin or viewer is installed, a CIS/2 file can be translated into a VRML model by 

opening up a CIS/2 file from the File menu (section 3.1.1 below) and clicking on the Translate and 

Display button (section 3.4 below).   

 

The display options in the user interface that affect the appearance of the VRML model are described in 

the sections 3 through 8.  Every time the display options are changed, the CIS/2 file must be translated 

and displayed again.  The VRML model cannot be updated without translating the CIS/2 file.  Selecting 

some display options might enable or disable other display options. 

 

If the CIS/2 file is named mycis2file.stp, then the resulting VRML file will be named 

mycis2file_ctv.wrl.  The file extension for VRML files is “wrl”. 

http://www.bitmanagement.com/en/products/interactive-3d-clients/bs-contact
http://www.cortona3d.com/Products/Cortona-3D-Viewer.aspx
http://cic.nist.gov/vrml/cosmoplayer.html
http://mediamachines.wordpress.com/flux-player-and-flux-studio/
http://octagavs.com/softwarem/octaga-player


 

 4 

 

SteelVis cannot translate an IFC file into a CIS/2 file, although some research related to this topic was 

done at Georgia Tech [7].  It also cannot translate a VRML file into a CIS/2 file or IFC file.  However, 

there is limited support for translating some types of CIS/1 and DSTV files to VRML files. 

2.5 Viewing the VRML Model 

Once the VRML model is displayed in the VRML plugin or viewer, the user can interactively navigate 

around the 3D model.  How the user interacts with the model depends on the VRML plugin.  For some of 

the display options, small round buttons will appear in the VRML browser that the user can click on to 

toggle on and off parts of the model.  The functionality of the buttons depends on the VRML plugin. 

 

A security warning might be displayed when trying to view a VRML model with a VRML plugin in 

Internet Explorer.  In this case click on the warning and select “Allow Blocked Content…”.   

2.6 Uninstalling SteelVis 

SteelVis can be uninstalled by manually deleting several files and directories.  Deleting the CTV directory 

will remove the SteelVis executable and associated files.  In a user’s home directory, the file 

SteelVis_options.dat can be deleted.  Finally, the desktop icon for SteelVis can be deleted. 
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3 User Interface 
 

Figure 1 shows the SteelVis user interface running on a Windows XP computer.  The appearance and 

functionality of the interface on a Windows 7 or Vista computer is similar.   

 

At the top of the user interface is the Menu Bar with the File, Browsers, Websites, and Help menus.  

Below that is the Tabs Bar with one tab for the Status window and the other tabs that provide access to all 

of the display options.  Below that is the Status window that shows the text feedback when SteelVis is 

running.  Clicking on one of the other tabs will switch to the user interface for that tab.  At the bottom is a 

row of four buttons and four images. 

 

 
 

Figure 1: SteelVis user interface  

 

< Menu Bar 

< Tabs Bar 
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3.1 Menu Bar 

3.1.1 File Menu 
 

From the File menu, shown in Figure 2, the user can select which CIS/2 file to open for translation.  

Multiple CIS/2 files can also be processed at one time.  The user will be asked to select a directory to 

search for CIS/2 files.  The search for multiple files can be restricted to only the selected directory or to 

include all subdirectories. 

 

Below the first solid line in the File menu is a list of up to 20 of the most recently translated CIS/2 files 

which can be opened directly.  The function keys F1 and F2 can be used to Translate and Display or Only 

Translate, respectively, the CIS/2 file that was most recently translated.  In addition to using the functions 

keys F1 and F2, the Translate and Display and Translate Only options can be selected from the bottom of 

the File menu. 

 

Below the list of CIS/2 files is a link to download a zip file of 25 sample CIS/2 files.  The zip file also 

contains X3DOM files that can be displayed without a VRML plugin or viewer (section 7.7 below) and 

Excel spreadsheets (section 8.3 below) generated from the sample CIS/2 files.  Other sample CIS/2 files 

are located in the sample subdirectory of the CTV directory where SteelVis is installed.  An explanation 

of those files is found in section 2.2 above. 

 

The Export Preferences option allows the user to export the current state of the SteelVis display options to 

a user-defined file.  That file can be imported to SteelVis with the Import Preferences option.  Preferences 

are a useful way to save and restore commonly used settings of SteelVis display options. 

 

Any VRML or IFC file can be displayed again with the Redisplay Any File option which can also be 

accessed with the F3 function key. 

 

 

 

 

Figure 2: File menu Figure 3: Browsers menu 
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3.1.2 Browsers Menu 
 

The Browsers menu, shown in Figure 3, is used to select which web browser, viewer, or program will 

display the VRML file when the Translate and Display or Display Again buttons (section 3.4 below) are 

clicked.  It shows a list of programs installed on the user’s computer where a VRML file might be 

displayed.  Programs are listed in the Browsers menu if they are installed in their default locations such as 

C:\Program Files or if there is a shortcut to them on the desktop.  The list of web browsers will always 

contain all web browsers found on the computer regardless if they have a VRML plugin installed in them.  

At a minimum, the Browsers menu will always contain Internet Explorer and the WordPad text editor. 

 

If a VRML file has already been generated, the user can select a different program in the Browsers menu 

and then click the Display Again button (section 3.4 below) to display the VRML file in the selected 

program. 

 

In the example list of browsers, Deep View 6, Instant Player, Xj3D, and Adobe 3D Reviewer are viewers 

that display VRML files.  Acrobat 9.0 Pro Extended is software used to embed a VRML file in a PDF 

document.  Chisel is a VRML file optimizer, VrmlPad is a VRML file editor, and TextPad is a text editor 

similar to WordPad.  VRML viewers, such as BS Contact and Flux Player that come with their associated 

VRML plugins, can also appear in the Browsers menu. 

 

3.1.3 Websites Menu 
 

The Websites menu, shown in Figure 4, provides links to useful resources related to SteelVis, VRML, 

CIS/2, and IFC. 

 

3.1.4 Help Menu 
 

The Help Menu, shown in Figure 5, has four sections.  In the first section, “What’s New” displays 

information in the Status tab about new features in SteelVis.  The “What’s New” information is 

automatically displayed every time a new version of SteelVis is run.    

 

“Check for Update” opens up a web page that checks for the latest version of SteelVis.  Follow the 

instructions on that web page to download a new version of SteelVis if one is available.  The “Check for 

Update” feature runs automatically if an update hasn’t been checked for in the last 30 days.   

 

“VRML Plugin Detector” runs the same check for a VRML plugin described in section 2.3 above. 

 

Selecting the other topics in the Help menu displays information related to them in the Status tab.   

 

Help is also available in the form of tooltips related to the display options in the tabs.  Holding the mouse 

over any text in a tab for a second or two will display a tooltip.  An example of tooltip help in the Detailed 

tab is shown in Figure 6. 

 

Previous to this user’s guide, the Help menu and tooltips were the only documentation available for 

SteelVis. 
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Figure 4: Websites menu 

 
Figure 5: Help menu 

 

 

 
Figure 6: Example of tooltip help 

 

3.2 Tabs Bar 

The tabs bar is located directly below the menu bar in Figure 1.  Clicking on a tab will switch from the 

current tab to the selected tab.  Except for the Status tab, the other tabs contain all of the SteelVis display 

options similar to Figure 6 above.  The display options in the tabs will be described in the sections below, 

in the context of their function rather than in the order of the tabs. 

3.3 Status Tab (Feedback) 

The Status tab displays important feedback during the translation of a CIS/2 file.  The information should 

not be ignored as it provides useful insight as to why the resulting VRML model or IFC file may not 
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appear as expected.  A brief example of the information in the Status tab is shown in Figure 1.  The types 

of messages that appear in the Status tab will depend on the CIS/2 file that is translated. 

 

The following is the general sequence of most of the information that appears in the Status tab when a 

CIS/2 file is translated: 

 

 Name of the program that generated the CIS/2 file and the time stamp in the CIS/2 file 

 Progress is indicated by a counter that increments by 5000 while the lines of the CIS/2 file are 

read 

 Total CIS/2 entities read 

 A list of all translated CIS/2 entities including the number of each entity 

 A list of all ignored CIS/2 entities that includes all entities not recognized by SteelVis or those 

that do not have to be processed depending on the selected display options 

 CIS/2 model type: Design, Analysis, or Detailed or any combination of the three 

 Messages about processing of units, lengths, coordinates, sections, copes, bolts, holes, openings, 

and assemblies depending on the CIS/2 model type.  Particular attention should be paid to the 

messages about “Processing: sections” (section 3.3.2 below). 

 Messages about generating the VRML model 

 Messages about generating the Summary Report if the option is selected, (section 5.1 below) 

 Messages about generating an IFC file if the option is selected, (section 9 below) 

 Names of the files that were generated and their size 

 Current configuration of the display options 

 

3.3.1 Error and Warning Messages 
 

The text or background color of the messages in the Status tab has significance: 

 

 Messages with a yellow background or red text are errors, warnings, or informational 

 Messages with a light blue background are related to generating an IFC file, (section 9 below) 

 Messages with a red background are syntax errors in the CIS/2 file and indicate a non-

conformance to the CIS/2 schema, however, SteelVis does not check for all syntax errors.  

Conformance to the schema and complete syntax checking can be performed with other tools, 

(section 8.4 below).  Use the option for ‘More warning and error messages’ in the Debug tab to 

report specific CIS/2 entities that are the cause of some syntax errors. 

 

Any of the error or warning messages might affect how the CIS/2 file is translated into a VRML model or 

IFC file.  However, any of the error or warning messages, including syntax errors, does not necessarily 

imply that the CIS/2 file cannot be used successfully to exchange information with other software 

applications. 

 

3.3.2 Processing of Sections 
 

The information in the Status tab regarding processing of sections can contain information about a 

common source of problems regarding the visual appearance the resulting VRML model.  A CIS/2 file 

can specify the explicit dimensions of sections such as the depth, width, web thickness, and flange 

thickness for an I-beam and other section types.  In this case, there is no ambiguity as to what the section 

dimensions are and how parts with those sections will appear in the VRML model.  If there are entities 

such as Section_profile_i_type, Section_profile_angle and other similarly named 

entities in the Status tab feedback related to the “Translated CIS/2 entities”, then these are CIS/2 entities 

that explicitly specify the dimensions of those sections.   
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However, it is also valid for a CIS/2 file to only specify the section designator such as W14X120 without 

any section dimensions.  If the entity Section_profile is present, then only the section designator is 

used to specify the section.  In this case, an internal lookup table is used to find the dimensions for the 

section.  The lookup table contains the section dimensions for over 4400 of the most commonly used 

sections from around the world.  Also included in the lookup table are equivalent names for the same 

sections.  For example, a 75PFC and 75X40X6PFC refer to the same section and have the same 

dimensions.  Similarly, an HEA100 and HE100A refer to the same section and a W14X61 and W14*61 

also refer to the same section.  The section designator that is used in the CIS/2 file is completely 

dependent on the software that generated the CIS/2 file. 

 

Some section types, such as angles and rectangular sections, are not included in the lookup table and the 

dimensions can usually be parsed directly from the section designator.  For example, an L250X125X13 is 

interpreted as an angle that is 250 mm deep, 125 mm wide, and has a thickness of 13 mm. 

 

In the VRML model, for all sections, webs and flanges always have constant thickness, and the fillets 

between webs and flanges are ignored.  Leg slope for angles is also ignored. 

 

If the dimensions for a section cannot be found in the lookup table then the section dimensions and 

section type (I-beam, angle, channel, etc.) will be parsed or approximated from the section designator.  

However, sometimes that approximation is wrong and the resulting VRML model will look incorrect for 

those sections that are approximated.  For example, if the section designator is only given as “SSMM-12”, 

there is no way to know what the section dimensions or type is.  In this case a rectangular section is used.  

There can also be ambiguities when interpreting the units of the numbers in the section designator.  If a 

number in a section designator (for example the “12” in “SSMM-12”) is interpreted to be in inches when 

it is actually millimeters, then the section will appear much too large. 

 

In the Status tab, if the CIS/2 file contains only explicit section dimensions, then there is no feedback for 

the “processing of sections”.  However, if the CIS/2 file contains any sections that are specified only by 

the section designator, then the feedback in the Status tab can contain any or all of the following 

information: 

 

 Number and name of sections found in the lookup table 

 Number and name of sections that were parsed from the section designator 

 Number and name of sections that were approximated from the section designator and their 

approximated dimensions and type 

 Number and name of sections that were not recognized 

 

Sections that are parsed, approximated, or not recognized might look wrong in the VRML model. 

 

The location of the longitudinal axis of a part relative to its cross section is known as the cardinal point in 

CIS/2.  The most common cardinal points such as top-of-steel or center of the section are processed, 

however, cardinal points for double sections, joists, and edge-defined sections are ignored.  If the cardinal 

point is ignored or approximated, then the part will appear slightly offset from its actual location.  
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3.3.2.1 Section Types 

 

Figure 7 shows an example of most of the different types of sections that SteelVis can write to a VRML 

file.  They are specified with explicit section dimensions or from dimensions found in the lookup table.  

The CIS/2 file for this example is cis2ifc_test3.stp in the sample directory (section 2.2 above).   

 

Row-by-row starting from the bottom left, the section types are: 

 

 I-beam, T-beam, channel, angle, cold-formed channel 

 Solid circular, hollow circular, solid rectangular, hollow rectangular, cold-formed zee 

 Tapered beam, plate, double channel, double angle, joist 

 Bent plate, corrugated decking, curved beam 

 

The representation of joists is only an approximation because the only information in a CIS/2 file about a 

joist section is its depth.  All joists are represented by double angles for the top and bottom chords and 

rectangular bars for the web. 

   

 

 
Figure 7: Section types 
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3.4 Translate Buttons 

The translate buttons are located at the bottom of the user interface, as shown in Figure 1, and have the 

following functions: 

 

 Translate Only – Translate the CIS/2 file and generate a VRML model, however, it is not 

displayed.  Optionally, an IFC file can also be generated, (section 9 below). 

 Translate and Display – Same as Translate Only but the VRML model is displayed in whatever 

web browser or viewer is selected in the Browsers menu (section 3.1.2 above).  Optionally, an 

IFC file can also be generated (section 9 below). 

 Display Again – Redisplay the VRML model in whatever web browser or viewer is selected in 

the Browsers menu (section 3.1.2 above).  This is useful to display the same VRML model in 

different VRML plugins, viewers, or editors without have to retranslate the CIS/2 file. 

 List Options – The current display options are listed in the Status tab. 

 

Below the Translate buttons are four images related to CIS/2, VRML, IFC, and NIST.  The images are 

links to web sites associated with the image. 
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4 Visual Appearance 
 

Many options are available to change the visual appearance of the VRML model.  Most of the settings for 

those options are found in the Colors, Rendering, and Other tabs.  Some of the options are applicable only 

to certain types of CIS/2 models or features in a CIS/2 file.  Some options are disabled or enabled 

depending on the selection of other options.  Every time the display options are changed, the CIS/2 file 

must be translated and displayed again.  The VRML model cannot be updated without translating the 

CIS/2 file. 

4.1 Color Options 

The options to change the colors assigned to members in the VRML model are found in the Colors tab as 

shown in Figure 8. 

 

 
Figure 8: Colors tab options 

 

Figures 9 through 12 are examples of the same VRML model colored using the first four color options.  

Figure 9 shows the model using the first Color by Section option.  For this option all I-beams and T-

beams are green, dark green, yellow, dark yellow, or cyan (light blue).  All other sections except plates 

are red, blue, magenta, and purple.  Bolts and welds are always orange.  Anything considered to be a plate 

is always grey.  Shear studs are always beige.  Members with the same cross section always have the 

same color, however, members with the same color do not always have the same cross section.  Figure 10 

shows the model using the second Color by Section option.  This is the same as the first option except that 

the color palette for the members is reversed.   

 

Figure 11 shows the model using the Color by Type option which assigns colors to the members based on 

their cross section type, i.e. I-beam, angle, channel, etc.  A legend shows the colors assigned to each type.  

Figure 12 shows the model using the Color by Function option which assigns colors to the members 
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based on their function.   How functions are specified for the members is completely dependent on the 

software that generated the CIS/2 file.  If functions are assigned to members they are displayed in the 

Summary Report (section 5.1.1 below). 

 

 

 
Figure 9: Color by Section (1) 

 

 

 
Figure 10: Color by Section (2) 

 

 

 
Figure 11: Color by Type 

 

 
Figure 12: Color by Function 
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The other options to color the VRML model are: 

 

 Color by Grade – Similar to Color by Function except that the name of the material assigned to a 

member is used as the basis for the color. 

 Color by Section Dimension – Color is assigned based on how the dimensions for a member’s 

cross section are determined, (section 3.3.2 above). 

 Color by IFC Type – Color is assigned based on the type of IFC entity used for a member, 

(section 9.2 below and Figure 60).  This option is enabled when an IFC file is generated from the 

CIS/2 file. 

 Color by Main Member – Some CIS/2 files differentiate between the main member of an 

assembly (e.g. a beam) and the other members in the assembly (e.g. angle brackets and gusset 

plates).  All main members will be one color and the other members another color.  CIS/2 files 

that contain main members use the entity Located_part_marked.  These entities can be 

checked for in the Status tab in the “Translated CIS/2 entities” section. 

 Color by Sequence – Color is assigned based on groupings of members by sequences or zones.  

All members in the same sequence or zone will have the same color.  This option is enabled 

when sequences and zones are translated in a detailed model, (section 6.1.3 below and Figure 

37). 

 Color by Surface Treatment – Color is assigned to members based on their surface treatment.  

CIS/2 files with member surface treatment have the entities Coating and 

Surface_treatment. 

 Color by Fabrication Status – Color is assigned to members based on their fabrication status.  

CIS/2 files with fabrication status information are not very common.  If this option is selected 

and the CIS/2 file contains the necessary entities need to assign colors, then after processing of 

the CIS/2 file has started, a dialog will appear and the status parameter can be selected that will 

be used to color members. 

 Color by Application – Color is assigned to members based on which software application 

created the member.  CIS/2 files with application information are not very common. 

 Rainbow – Color is assigned to members randomly. 

 Grey – All members are colored grey. 

 

Parts that cannot be assigned a color based on the selected color option will appear grey.  If a color option 

is selected that does not apply to the type of CIS/2 model being translated, then the entire VRML model 

will appear grey and a message will appear in the Status tab.   

 

4.1.1 Background Color 
 

Four different background colors can be displayed in the VRML model: white/grey, white, black, and 

sky/ground.  The white/grey background is used in all of the figures with VRML models. 
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4.2 Rendering Options 

The options to change how members are rendered in the VRML model are found in the Rendering tab as 

shown in Figure 13. 

 

 
Figure 13: Rendering tab options 

 

Figures 14 through 17 are examples of the same VRML model with displayed with different rendering 

options.  In Figure 14, all of the members, bolts, holes, and welds are transparent.  The anchor rods in the 

base of the structure are now visible.  Figure 9 is the same model displayed with shaded (non-transparent) 

rendering. 

 

In Figure 15, most of the members are displayed only by their edges.  Bolts, holes, and welds are 

displayed only with lines.  Bent plates, corrugated decking, and curved parts cannot be displayed by only 

their edges. 

 

Figure 16 uses the fourth option in the Rendering tab for shaded, transparent, edge, and wireframe.  This 

option requires the “VRML with PROTOs” option in the More VRML tab (section 7.9 below).  The 

different rendering options can be selected directly in the VRML display.  In this VRML model, there are 

also buttons to toggle on and off the bolts, holes, and welds.  This rendering option is not recommended 

for very large CIS/2 models. 

 

Figure 17 shows the VRML model with all three of the Simplify VRML Model options turned on.  

Ignoring the thickness of member greatly reduces the number of surfaces that have to be displayed in the 

VRML model.  This is useful for very large CIS/2 models or when displaying the VRML model on 

slower computers.  Bolts, holes, and welds are displayed only by lines.  Since the base of the structure is 

modeled as a plate, it is displayed as a surface through the middle of the plate. 
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Figure 14: Transparent rendering 

 

 
Figure 15: Edge rendering 

 

 
Figure 16: Rendering options in VRML model 

 
Figure 17: Ignoring thickness of members 
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4.3 Title, Ground Plane, Origin Axes 

Figure 18 shows the options to generate a title, ground plane, and origin axes in the VRML model.  

  

 
Figure 18: Title, ground plane, and origin axes options 

 

Figure 19 shows a VRML model with a title, ground plane, and origin axes.  The title in the VRML 

model is based on text information found in the CIS/2 file.  If no text information is found in the CIS/2 

file, a title is generated based on the type of CIS/2 model and the name of the software that created the 

CIS/2 file.  A user-defined title can be specified to override the automatically generated title.  The title 

might not be displayed in some VRML plugins and viewers. 

 

The ground plane is shown as a rectangular outline at the base of the structure.    The base of the structure 

is considered to be the lowest point in the structure.  This is not necessarily the level of the “ground” in 

the structure. 

 

The small origin axes (in blue) are visible at the base of the corner column on the left.  The origin axes are 

displayed at the coordinates 0,0,0 in the VRML model which might not be near the actual structure and 

therefore not visible in the VRML model. 

 

 
Figure 19: VRML model with title, ground plane, and origin axes 
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4.4 Viewpoints 

Figure 20 shows the options related to generating viewpoints in the VRML model.  The viewpoints can 

be accessed in the VRML plugin or viewer that displays the VRML model.  Typically, the PageUp and 

PageDown keys can be used to cycle through the viewpoints in the VRML plugin or viewer. 

 

 
Figure 20: Generate viewpoint options 

 

Thirteen default viewpoints corresponding to various Front, Side, and Top viewpoints are automatically 

generated.  Optionally, an animated spinning and parallel (orthographic) projection viewpoints can be 

generated.  Both types of optional viewpoints might not work in some VRML plugins and viewers.  Using 

the Front Only option generates only one default viewpoint. 

 

4.4.1 User-Defined Viewpoints 
 

User-defined viewpoints are useful when sharing the VRML model to show another user where to look in 

the VRML model.  It takes several manual steps to add user-defined viewpoints to the VRML model: 

 

1. Select a CIS/2 file to translate.  This will enable the User-defined viewpoints option. 

2. Check the option for User-defined viewpoints.  This will enable the “Open Viewpoints File” 

button. 

3. Click the “Open Viewpoints File” button.  This will open a file in a text editor.  Text that will be 

displayed in the VRML model must be entered in the file to record the user-defined viewpoints. 

4. Click the “Translate and Display” button.  An example VRML model with the viewpoint text is 

shown in Figure 21.  As the VRML model is rotated, the values for the position and orientation 

will update.  For each user-defined viewpoint, the exact text from and including ‘Viewpoint {’ to 

the ending ‘}’ must be entered in the viewpoints file.  In this example, the text is: 

 
Viewpoint { 

  position -247.556 -59.253 498.702 

  orientation .224 -.972 0.065 .428 

  description “Put my description here” 

} 

 

Any text can be used for the description.  Clicking on the text “Click here to show viewpoint 

text” might open up a text window with the text that needs to be entered in the viewpoints file.  If 

the text window appears, the viewpoint text can be copied from the text window and pasted into 

the viewpoints file.   

5. Repeat the process of adding the text associated with the viewpoints to the viewpoints file for 

each user-defined viewpoint. 

6. Save the viewpoints file and close it.  Use the default name and location of the file. 

7. Uncheck the option for User-defined viewpoints. 

8. Click the “Translate and Display” button again.  The saved viewpoints will be automatically 

included in the resulting VRML model every time the CIS/2 file is translated.  The text for user-

defined viewpoints will appear in the VRML plugin or viewer’s menu of viewpoints. 
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Figure 21: VRML model with viewpoint text 

 

  



 

 21 

5 Text Reports 
 

Text reports include several ways to display text information related to the CIS/2 file in the VRML model 

or in a summary file.  Most of the options related to text reports are in the Reports tab.  The user interface 

for generating a summary report or text popups is shown in Figure 22. 

 

 
Figure 22: Reports tab options 

 

5.1 Summary Report 

The summary report is an HTML file that is displayed in the web browser and includes for all models, a 

list of all parts and materials.  Information about assemblies and bolts are also included for detailed 

models.  Figures 23 through 26 show portions of information that are available in the summary report.  

The summary report might also have information about the software used to generate the CIS/2 file, the 

user who generated the CIS/2 file, and other drawings associated with the model.   

 

Options are also available to generate the summary report with minimal formatting or in an Excel 

spreadsheet.  Either of these options might be useful to import the summary report into other applications. 

 

If the CIS/2 file is named mycis2file.stp, then the resulting summary report file will be named 

mycis2file_sum.html. 
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5.1.1 Part List 
 

The headings for the summary report part list shown in Figure 23 are: 

 

 Qty – quantity of the part 

 Mark – piecemark of the part 

o design and analysis models usually do not have a piecemark and are listed as n/a 

o if the part is the main member of an assembly, then the piecemark text is bold 

 Size – section designator of the part 

o for plates that do not have a section designator, rectangular plates are listed as, for 

example, Plate (0-8x0-3) and non-rectangular plates are listed as Plate (Complex) 

o the size is linked to the Material List   

 Length – part length in feet and inches or the native units of the CIS/2 file depending on the 

selection in the Report tabs 

o if the length cannot be listed with fractions for inches, then decimal values are used 

o the “length” of a plate is the thickness of the plate and is listed as T=3/4 

 Grade – material grade of the part 

 Unit Wgt – unit weight of the part, see section 5.2 below for how weight is calculated 

 Total Wgt – total weight of all the type of parts 

 Function – the function depends on text information in the CIS/2 file 

 

 
Figure 23: Summary report part list 

 

Other information might be included in the part list and is dependent on the type of CIS/2 model and 

information written to the CIS/2 file, including: 

 Holes per part – number and diameter of holes in the part 

 Copes per part – number of type of copes (cutouts) per part 

 Plate area and perimeter – area and perimeter length of the plate 

 Orientation – in an analysis model, rotation angle of the part about its longitudinal axis 

 Surface – surface treatment 

 Part drawing, assembly drawings, CNC – links to drawings and CNC files 

 Prelim Mark – preliminary marks 

 Information related to advanced bills of material and fabrication status 
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5.1.2 Material List 
 

The headings for the summary report material list shown in Figure 24 are: 

 

 Size, Grade – same as for the part list above 

 Total Length – total length of all the parts of the same size 

 Total Weight – total weight of all the parts of the same size, (section 5.2 below) 

 Pieces – quantity of parts of a size 

 Color – color of the part in the VRML model if the colors associated with the part size are unique 

 

 
Figure 24: Summary report material list 

  



 

 24 

5.1.3 Assembly List 
 

The assembly list applies only to detailed models.  The headings for the summary report assembly list 

shown in Figure 25 are: 

 

 Qty – quantity of the assembly 

 Mark – piecemark of the assembly 

 Function – the function depends on text information in the CIS/2 file 

 Unit Wgt – unit weight of the assembly, (section 5.2 below) 

 Parts Per Assembly – piecemarks all the parts in the assembly 

o the number of parts is listed parenthetically before the part piecemark 

o the part piecemarks are linked to the Part List 

 

 
Figure 25: Summary report assembly list 

 

Other information might be included in the assembly list and is dependent on the information written to 

the CIS/2 file, including: 

 

 Bolts per assembly – number and size of bolts in the assembly 

 Welds per assembly – number, type, and length (if available) of welds in the assembly 

 Drawing – links to assembly drawings 

 Information related to advanced bills of material and fabrication status 
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5.1.4 Bolt List 
 

The bolt list applies to detailed and design models.  Shear studs are also included in the bolt list.  The 

headings for the summary report bolt list shown in Figure 26 are: 

 

 Qty – quantity of the bolt type 

 Type – bolt diameter and length, Site or Shop, number and size of washers 

 

 
Figure 26: Summary report bolt list 

 

5.2 Weight in Text Reports 

The weight of parts is not included in CIS/2 files.  The weight reported in the summary report and text 

popups is computed by SteelVis and may not be accurate.  The following cautions should be noted when 

considering the accuracy of the weight reported: 

 

 Weight is computed from the part length and weight per length 

 Weight computations might be affected by conversions between units for mass or units for length 

 Weight is not computed for non-steel parts such as concrete, if they can be identified 

 Weight for a part is not reduced by any material removed for copes, holes, and openings 

 Weight per length for some sections comes from the lookup table (section 3.3.2 above) 

o Sections not found in the lookup table will approximate the weight per length based on 

the cross section dimensions and density of steel 

 Weight for plates is based on the actual volume of the plate regardless of its shape 
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5.3 Text Popups 

Text popups are short pieces of information related to parts, assemblies, bolts, welds, holes, analysis 

elements, loads, displacements, reactions, and design parts that appear (popup) in the VRML plugin, 

viewer, or the web browser status line when the mouse pointer is held over one of those items.  The 

functionality of text popups is dependent on the VRML plugin, viewer, or the web browser.  The options 

for text popups are found in the Reports tab as displayed in Figure 22 above.  Two types of text popups 

are available; text popups in a tooltip and text popups in the VRML plugin or viewer.   

 

5.3.1 Text Popup in a Tooltip 
 

Figure 27 is an example of a text popup in a tooltip displayed with the Cortona3D VRML plugin.  Figure 

28 is an example of a text popup in a tooltip displayed with the Cosmo Player VRML plugin where the 

text appears in the status bar of the web browser.  For web browsers that do not have a status bar such as 

Firefox, the tooltips for Cosmo Player cannot be displayed. 

 

In these examples, five pieces of information are in the tooltip. 

 

1. B_1[1] – piecemark of the assembly that the part is associated with 

2. w4[12] - part piecemark 

3. W12x22 - section designator 

4. L=9-11 ¼ - length 

5. W=219 - weight 

 

 
Figure 27: Tooltip text popup in Cortona3D 

 

 
Figure 28: Tooltip text popup in Cosmo Player 

 

Other information might be included in the tooltip and is dependent on the information written to the 

CIS/2 file.  The information is similar to the information for the same item that is written to the summary 

report.   

 

Sometimes the amount of the information is too long to be easily displayed in the tooltip.  In this case, the 

text will begin with “Click for more:”.  Clicking on the item will open a web browser window with the 

complete text information.  This feature only works when web browser popups are allowed or the web 

browser popup blocker is disabled.  Figure 29 shows the tooltip text popup with assembly information 

displayed with the “Click for more:” feature.  The text lists the four parts and bolts in the assembly.  This 

type of text popup is the only way information about loads and reactions can be displayed for analysis 

models, however, it does not work in Internet Explorer. 
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Figure 29: Tooltip text popup with assembly information in a separate web browser window 
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5.3.2 Text Popup in the VRML Browser 
 

An example of the text popup in the VRML browser is shown in Figure 30.  The text information is for 

the entire assembly (similar to Figure 29) and overlays the VRML display.  This method of displaying the 

text popup in the VRML browser depends in the VRML plugin or viewer.  This option is not 

recommended for very large CIS/2 files. 

 

 
Figure 30: Text popup in the VRML browser 
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5.4 Member Labels 

The option for “Piecemark label for each member” can be selected in the Other tab.  An example of the 

labels is shown in Figure 31.  The labels usually contain the part piecemark and the section designator.  

The label is scaled for the length and depth of the member and is located at its mid-length.  In the VRML 

browser, the labels rotate so that they always face forward and labels that are too small to be legible are 

not displayed.     

 

 
Figure 31: Member labels 
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6 Model Specific Features 

6.1 Detailed Model 

The options related to detailed models are in the Detailed tab and are shown in Figure 32.   

 

 
Figure 32: Detailed model options 

 

 

6.1.1 Copes, Camber 
 

The types of copes (cutouts) that are translated are: notches, chamfers, flange notches, flange chamfers, 

miter cuts, and cutting planes.  Other types of copes that can be modeled in CIS/2 are not supported by 

SteelVis.  Copes are not displayed on curved parts, plates, decking, and parts with a zee cross section.  

Some copes are not displayed on parts with a circular or rectangular cross section.  Complex 

combinations of copes might not be displayed correctly in the VRML model.   

 

If camber is included in the CIS/2 file, an approximation for its appearance is used in the VRML model.  

Cutting planes can be toggled on and off in the VRML model but they do not remove material from the 

parts they are associated with. 

 

In Figure 33, the dark blue channel to the left of the I-beam has a miter cut on the right end and the 

magenta channel to the right of the I-beam has a notch on the bottom left end. 
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Figure 33: Parts with copes (cutouts) 

 

 

6.1.2 Bolts, Holes, and Welds 
 

Figure 34 shows several connections with bolts, holes, welds, and a shear stud.  Figure 35 shows the same 

connections without the bolts and shear stud.  Bolts always have a hexagonal head.  If nuts and washers 

are included in the CIS/2 file, they are represented by hexagonal and circular rings, respectively, around 

the shaft of a bolt.  The size and position of the rings do not reflect the actual size and position of the nuts 

and washers.  If two circular rings are displayed, then two washers are used with the bolt, however, the 

second washer is usually located under the head of the bolt.  A beige colored shear stud is visible in the 

lower right of Figure 34. 

 

If weld paths are included in the CIS/2 file, they are represented by an orange fillet between the parts that 

are welded together.  The cross section of the weld does not reflect the actual size, type, and geometry of 

the weld.  The orange weld fillet might appear distorted if the weld path has sharp corners.  If welds 

without weld paths are included in the CIS/2 file, their location is represented by an orange weld symbol 

as shown in Figure 36. 

 

Holes and openings are represented by a black surface patch on the part through which the hole is drilled 

or the opening is cut or formed as seen in Figure 35.  Holes can be circular, slotted, or rectangular.  

Openings, such as web penerations, can be any arbitrary shape.  In some CIS/2 files, holes with a zero 

radius are used to represent a specific location on the part and are represented by an “X” in the VRML 

model.  Holes and openings are not displayed on curved parts, bent plates, decking, and parts with a 

circular cross section. 

 

Design models can also have shear studs, holes, and openings. 
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Figure 34: Parts with bolts, nuts, washers, holes, welds, shear stud 

 

 
Figure 35: Parts with holes and welds 
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Figure 36: Welds represented by an orange weld symbol 
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6.1.3 Sequences 
 

If sequences are included in the CIS/2 file and sequences option is selected in the Detailed tab, then it is 

possible to toggle on and off the individual sequences in the VRML model.  Figure 37 shows a structure 

with five sequences.  Each sequence has a small round button associated with it to toggle on and off the 

parts in that sequence.  In this example, the decking in sequence 4 is toggled off.  Color is assigned based 

on groupings of members by sequences (section 4.1 above).  All members in the same sequence have the 

same color.  If sequences are written to the CIS/2 file, they do not necessarily represent an actual 

construction sequence.   

 

 
Figure 37: Structure with sequences 

 

  



 

 35 

6.1.4 Excluding Parts 
 

In a detailed model, it is possible to exclude some types of members from the resulting VRML model.  

The options to exclude parts are the two options titled “Do NOT translate …” in the Detailed tab as 

shown in Figure 32 above.  This is useful when displaying very large CIS/2 files.   

 

The types of members that can be excluded are non-main parts in an assembly and any plates.  CIS/2 files 

with main members use the entity Located_part_marked and can be checked for in the Status tab in 

the “Translated CIS/2 entities” section.  Non-main parts in an assembly are typically angle brackets and 

gusset plates.  Figure 38 shows a structure with the non-main parts and plates excluded. 

 

 
Figure 38: Structure with non-main parts and plates excluded 
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6.1.5 Assemblies 
 

Options are available to generate assembly viewpoints and assembly on-off switches in the VRML model.  

Assembly viewpoints are added to the default set of viewpoints (section 4.4 above).  The viewpoint will 

position and orient the VRML model near the origin of the assembly.   

 

Figure 39 shows a structure with assembly on-off switches.  The switches appear as a red or green 

transparent cube in the VRML model.  The text in the center of the cube is the assembly piecemark.  

Clicking on a red cube will hide the assembly it is associated with and the cube will turn green.  Clicking 

on a green cube will make assembly visible again.  In this example assembly “2-2” is hidden.  This is a 

useful method to determine which parts and bolts are and are not associated with an assembly.   

 

 
Figure 39: Structure with assembly on-off switches 
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6.2 Analysis Model 

6.2.1 Nodes and Wireframe 
 

The options for analysis models are in the Other tab and are shown in Figure 40.  The VRML model for 

an analysis model will always include the physical representation of the analysis elements.  If the 

wireframe and nodes options are selected, then the wireframe analysis model and nodes are displayed as 

shown in Figure 41.  Nodes are represented in the VRML model as a small transparent orange cube.  

VRML buttons can be used display to toggle on and off the physical representation of the analysis 

elements, the wireframe analysis model, and the nodes.  In this example the analysis model elements are 

turned off.  The wireframe model does not account for any analysis element eccentricity. 

 

Analysis model loads, displacements, and reactions are not displayed in the VRML model.  The only 

option for any feedback about loads, displacements, and reactions is with a text popup (section 5.3.1 

above). 

 

 
Figure 40: Analysis model options 

 

 

 
Figure 41: Analysis model wireframe and nodes 
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6.3 Design Model 

The options for design models are in the Other tab and are shown in Figure 42.  Design connections and 

design joints systems as described below, however, they are not often included in CIS/2 files.  Some 

design models also contain shear studs, holes, and openings.  Options for those features are in the 

Detailed tab and are described in section 6.1.2 above. 

 

 
Figure 42: Design model options with tooltip help 

 

 

6.3.1 Design Connections 
 

A design connection indicates that a structural connection, such as a beam to column or beam to beam 

connection is to be made between several structural members.  Design connections appear in the VRML 

model as a transparent grey sphere located near the intersection of the longitudinal axes of the connected 

parts but not necessarily where the parts are actually connected.  The sphere for an external connection 

might not be displayed at the correct end of a member. 

 

Figure 43 shows internal design connections between several members.  If text popups are enabled for 

design parts (section 5.3.1 above), then information about the design connection will be associated with 

the grey sphere.  In this example, the design connection is an internal connection that connects four parts, 

M341, M377, M394, and M52.  CIS/2 files with design connections use the entity 

Assembly_design_structural_connection_internal and can be checked for in the Status 

tab in the “Translated CIS/2 entities” section. 

 

 
Figure 43: Internal design connection between four parts 
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6.3.2 Design Joint System 
 

A design joint system is a conceptual device for connection design.  It is a representation of what type and 

materials should be used for a connection design without actually modeling the exact details of the 

connection.  Design joint systems appear in the VRML model as an inverted transparent grey pyramid 

where the physical connection should be located.  Figure 44 shows design joint system at the end of a 

beam.  If text popups are enabled for design parts (section 5.3.1 above), then information about the design 

joint system will be associated with the grey pyramid.  In this example, the design joint system indicates 

that the connection at the end of beam B_11 should use bolted double clip angles.  CIS/2 files with design 

joint systems use the entity Design_joint_system and can be checked for in the Status tab in the 

“Translated CIS/2 entities” section. 

 

 
Figure 44: Design joint system 
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7 Other Features 
 

The options for the features described in this section can be found in the Other, VRML, and More VRML 

tabs. 

7.1 Grid Lines 

If grid lines are included in the CIS/2 file, they can be displayed in the VRML model by selecting the 

option for Grid Lines in the Other tab.  Figure 45 shows a VRML model with orthogonal and radial grid 

lines.   

 

 
Figure 45: Orthogonal and radial grid lines 

 

CIS/2 files can also contain grid levels as shown in Figure 46.  The grid levels appear as lines on the left 

and back sides of the VRML model and typically represent the elevation of that level.  Buttons also 

appear in the VRML model to toggle on and off the grid lines and grid levels.  Some CIS/2 files have so 

many grid lines and levels that displaying them in the VRML model creates too much clutter in the 

display. 
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Figure 46: Grid lines and levels 

 

7.2 Vertical Axis 

For almost all CIS/2 models, the vertical axis of the model is the positive Z axis.  If the vertical axis of the 

model is the positive Y axis, it can be selected with the Vertical Axis option in the Other tab. 

7.3 Model Types 

A CIS/2 file can contain a design, analysis, or detailed model.  Some CIS/2 files contain multiple models, 

i.e. design and analysis models.  If the CIS/2 file contains multiple models, then the VRML model will 

contain buttons to toggle on and off each model as shown in Figure 47.  In many cases the design and 

analysis model will look the same.  If only one of the model types is of interest, then the model type that 

is translated can be selected with the Model Type option in the Other tab.  When the CIS/2 file is 

translated, the model type is reported in the Status tab (section 3.3 above). 

 

 
Figure 47: Model with design and analysis models 
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7.4 Curved Parts 

Curved parts also include bent plates and corrugated decking (see Figure 7).  The geometry of the curve 

for a curved part can be represented in many ways in a CIS/2 file.  SteelVis only supports curves defined 

by a polyline or a b-spline.  Other types of curve geometry are ignored and the part will appear straight.   

 

Plates and slabs with curved edges defined by curves other than a polyline will display the curved edges 

as straight. 

 

How the curved part appears in the VRML model also depends on the VRML plugin or viewer.  Use the 

VRML Plugin option in the VRML tab to select which VRML plugin is used to display the VRML 

model.  If the VRML plugin is not listed, select the Other option. 

7.5 Navigation Mode 

The navigation mode refers to how the user rotates, navigates, and interacts with the VRML model in the 

VRML plugin or viewer.  The navigation mode can be selected with the Navigation Mode option in the 

VRML tab.  The Examine mode treats the VRML model as if it were an object that the user can hold in 

their hands.  The actual interaction with the VRML model depends on the VRML plugin or viewer.   

7.6 Merging Models 

Merging VRML models is a way to automatically include another VRML model with the one generated 

by SteelVis.  Figure 48 shows the options for merging VRML models in the VRML tab.  To enable this 

option, select Merge File and Browse for the VRML file to be merged.  The Merge Scale, Translation, 

and Rotation are applied to the selected VRML file to align it with the VRML model generated by 

SteelVis. The Do Not Center VRML model option is useful to help align the two VRML models.  By 

default, the VRML model generated by SteelVis is always centered about 0,0,0.  

 

The rotation is specified by four values.  The first three numbers are an axis about which the model is 

rotated.  The fourth number is the rotation angle in radians.  The selectors to the right of the rotation value 

can be used to select typical axis and rotation angles in degrees which are converted to the required four 

rotation values. 

 

 
Figure 48: Merging VRML model options in the VRML tab 

 

Figure 49 shows an example of merging a VRML model of the NIST logo with the VRML model 

generated by SteelVis.  Buttons appear in the VRML model to toggle on and off the merged VRML 

model and the CIS/2 model. 

 

A screenshot of another example of merging VRML models can be found in the Websites menu under 

VRML Information.  In that example, a VRML model of the adjacent buildings, equipment, and terrain 

was merged with the VRML generated by SteelVis to show the structural steel model in the context of its 

surroundings. 
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Figure 49: Merged VRML models 

 

7.7 X3D and X3DOM 

X3D is the successor to VRML and is encoded using the Extensible Markup Language (XML) [8].  Many 

of the VRML plugins and viewers also can display X3D files.  X3DOM is a way to embed an X3D file 

directly in a web page and display the 3D model in a web browser without a VRML or X3D plugin or 

viewer [9].  X3DOM files generated by SteelVis can only be displayed in web browsers that support 

WebGL such as current versions of Firefox, Google Chrome, or Internet Explorer 9 with Flash 11.  For 

Internet Explorer 9 all Compatibility View settings must be disabled.  Information about generating X3D 

and X3DOM files can be found in the SteelVis Help menu.  A link to a sample X3DOM file generated by 

SteelVis can be found in the Websites menu under CIS/2 Information.  Some of the features of the VRML 

model generated by SteelVis are not supported by X3DOM. 

 

The options to generate an X3D or X3DOM file are in the More VRML tab.  SteelVis uses the 

InstantReality Framework to generate X3D and X3DOM files.  A link to the InstantReality website can 

be found in the Websites menu under VRML Information.  After InstantReality is downloaded and 

installed, then X3D and X3DOM files can be generated.  InstantReality also includes a VRML and X3D 

viewer called Instant Player that will show up in the Browsers menu (section 3.1.2 above). 
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7.8 Simple VRML 

The VRML that is generated by SteelVis is highly optimized to minimize the VRML file size and the 

computations required to generate the geometry in a VRML plugin or viewer.  However, some software 

that displays VRML files does not support the optimized VRML generated by SteelVis.  In this case, use 

the Simple VRML option in the More VRML tab which will generate simple non-optimized VRML that 

can be imported by almost any software. 

 

The other options related to the VRML node name and embedding VRML in a 3D PDF file are described 

in the Help menu and tooltip help.  Figure 50 is an example of a VRML model embedded in a PDF 

document.  Click on the model to rotate it and to access other features of the 3D model.  The interactive 

features of the model are only available in Adobe Reader.  Other examples of VRML models embedded 

in 3D PDF files can be found in the Websites menu under CIS/2 Information. 

7.9 VRML PROTOs 

VRML PROTOs are programming scripts written in JavaScript that are included in the VRML model to 

provide added functionality.  PROTO is short for Prototype.  For example, in many if the examples 

above, the buttons that toggle on and off parts of the VRML model are generated with a VRML PROTO.  

The use of VRML PROTOs by SteelVis in VRML models is transparent to the user.   

 

However, there is one display option that requires using the VRML with PROTOs option in the More 

VRML tab.  That option is the rendering option for “Shaded, transparent, edge, and wireframe” in the 

Rendering tab (section 4.2 above and Figure 16).  The use of VRML PROTOs also creates the buttons to 

toggle on and off the bolts, holes, and welds.   

 

The VRML with PROTOs option is not recommended for very large CIS/2 models.  For some VRML 

plugins, viewers, and other software that can display VRML files, parts of the VRML model that are 

displayed with PROTOs will not be visible. 
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Figure 50: Interactive 3D model 
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8 Debugging Features 
 

Most of the debugging features can be found in the Debug menu as shown in Figure 51.  Two other 

debugging options can be found in the Reports and Detailed tabs. 

 

 
Figure 51: Debug tab options 

 

8.1 Coordinate Axes 

Coordinate axes can be included in the VRML model for any assembly, parts, bolt layout, weld, hole 

layout, analysis element, or design part.  They are useful to confirm the absolute and relative position and 

orientation of items in the VRML model.  The coordinate axes are displayed at the position where the 

item is located in the CIS/2 model and includes a text label.  The text label rotates so that it always faces 

forward and contain information relevant to that item. 

 

Figure 51 shows coordinate axes for an assembly and a transparent beam and plate.  The assembly 

coordinate axes are black and the two part coordinate axes are blue.  Figure 52 shows the coordinate axes 

for two angle brackets and a bolt layout.  The part coordinate axes are blue and the bolt layout coordinate 

axes are red.   

8.2 CIS/2 File Checking 

Several options are provided to check the contents of the CIS/2 file.  Some of the options depend on other 

optional software.  At a minimum in the Check CIS/2 File of the Debug tab, the two options in the first 

row of that section will be available.  The “View” button will display the CIS/2 file in a text editor and the 

“Indent” option will also display the CIS/2 file in a text editor, however, the CIS/2 entities will be 

rearranged and indented to show the hierarchy of information in the CIS/2 file.   

 

Figure 54 shows a sample of the output using the “Indent” option.  In this example, it is easy to see how 

the definition of the axis (#20=AXIS2_PLACEMENT_3D) refers to the cartesian point (#35) and two 

directions (#33, #32) and how the axis is referred to by the design part (#14) through the coordinate 

system (#17). 
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Figure 52: Assembly and part coordinate axes 

 
Figure 53: Part and bolt coordinate axes 

 

 

 
#14=DESIGN_PART('C-1',#23,(#43),(#17)); 

  #23=PART_PRISMATIC_SIMPLE(1,'A36',$,$,.UNDEFINED.,$,#46,#40,$,$); 

    #46=SECTION_PROFILE(1,'W10X45',$,$,2,.F.); 

    #40=POSITIVE_LENGTH_MEASURE_WITH_UNIT(POSITIVE_LENGTH_MEASURE(12.),#53); 

      #53=(CONTEXT_DEPENDENT_UNIT('FOOT')LENGTH_UNIT()NAMED_UNIT(#54)); 

        #54=DIMENSIONAL_EXPONENTS(1.,0.,0.,0.,0.,0.,0.); 

  #43=ASSEMBLY_DESIGN_STRUCTURAL_MEMBER_LINEAR(0,'C-

1',$,$,0,.LOW.,.T.,.F.,(),(),.T.,.UNDEFINED_ROLE.,.PRIMARY_MEMBER.,.COLUMN.); 

  #17=COORD_SYSTEM_CARTESIAN_3D('Design Part','Design Part Coordinate System',$,3,#20); 

    #20=AXIS2_PLACEMENT_3D('Axis3d',#35,#33,#32); 

      #35=CARTESIAN_POINT('Origin',(-29.5263471800601,37.8979091266392,0.)); 

      #33=DIRECTION('Direction',(1.,0.,0.)); 

      #32=DIRECTION('Orientation',(0.,0.,1.)); 

Figure 54: CIS/2 file with indentation 

 

 

The options in the second row of the Check CIS/2 File section are to “Generate” an Excel spreadsheet 

from the CIS/2 file and to “View” the CIS/2 file with the IfcQuickBrowser.  The IfcQuickBrowser is a 

free IFC file browser that also works with CIS/2 files [10].   

8.3 Generate Excel Spreadsheet 

To generate an Excel spreadsheet from a CIS/2 file, the CIS/2 File Analyzer (CIS2_Excel.exe) must 

first be setup.  The CIS/2 File Analyzer uses IFCsvr [11] which is a program that can read and process 

IFC files that also works with CIS/2 files.  The Analyzer will check for IFCsvr and install it, if it is not 

already installed.  Any version of Microsoft Excel is required to generate a spreadsheet.  Running the 

Analyzer the first time will create an icon on the desktop for “CIS2 File Analyzer”.  The CIS/2 File 

Analyzer is based on the IFC File Analyzer [12, 13].  

 

Figure 55 shows the user interface for the CIS/2 File Analyzer.  Options are available to selectively 

process different types of CIS/2 entities as shown in Figure 56.  Sometimes the Analyzer will not be able 

to completely process a CIS/2 file due to a problem in the file.  In that case, the feedback in the Status tab 
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will show at which entity type the processing stopped.  In the Options tab, deselect that type of entity and 

try generating the spreadsheet again.  Typically, the “representation” entity is the cause of the problem. 

 

The spreadsheet generated by the Analyzer creates a summary worksheet as shown in Figure 57.   All of 

the entity types found in the CIS/2 file are listed in Column A starting after row 7.  The name of each 

entity is linked to the individual worksheet for that entity.  Column B is the number of each entity type 

found in the CIS/2 file.  Column C is a link to CIS/2 documentation for that entity. 

 

A worksheet is created for each entity in Column A of the summary worksheet.  Figure 58 shows the 

worksheet for the CIS/2 “material” entity.  Cell A1 is the name of the entity and number of that entity.  It 

is also a link back to the summary worksheet.  Cell A2 is a link to CIS/2 documentation for that entity.  

The CIS/2 entity ID is in Column A starting with row 4.  Row 3 starting with column B has the names of 

all of the attributes for the “material” entity.  Each row starting with row 4 contains the values of the 

attributes for each of the nine “material” entities.  Similar worksheets are created for every CIS/2 entity 

type. 

 

 
Figure 55: CIS/2 File Analyzer user interface 
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Figure 56: CIS/2 File Analyzer options tab 

 

 
Figure 57: Summary worksheet 
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Figure 58: Worksheet for the material entity 

 

8.4 File Validation 

The option in the third row of the Check CIS/2 File section is to “Validate” the CIS/2 file with Express 

Engine.  Although many syntax errors are highlighted in red in the Status tab (section 3.3.1 above), 

SteelVis does not validate that the CIS/2 file conforms to the CIS/2 schema.  Use the option for ‘More 

warning and error messages’ in the Debug to report specific CIS/2 entities that are the cause of some 

syntax errors. 

 

Checking for conformance to the schema can be done with several commercial tools, such as EDM 

Supervisor and STEP Tools, and with free tools such as Express Engine [14] that was formerly known as 

NIST Expresso [15].  When Express Engine is installed, the option to “Validate” the CIS/2 file with 

Express Engine will appear in the Debug tab.  When using this option, if the CIS/2 file is named 

mycis2file.stp, then the Express Engine output will be written to the file mycis2file_ee.log.  

More information about using Express Engine can be found in the Help menu under Validating CIS/2 

Files. 
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9 Generating an IFC File 
 

A CIS/2 file can be translated to an IFC file so that the structural steel model can be imported to BIM 

applications that support IFC files.  The capability to translate CIS/2 files into IFC files is based on 

research at NIST to develop a mapping between the information, entities, and attributes of each file type 

[16, 17].  SteelVis implements the mapping described in the research, however, the most important 

characteristic of translating a CIS/2 file to an IFC file is that there is no single correct way to do it.  Any 

combination of IFC options described below will result in a valid IFC file, however, the BIM application 

importing the IFC file might not support how the steel structure is modeled in the IFC file.  Support 

depends on how information in the resulting IFC file is mapped to the internal representation of those 

features in the BIM application.   

 

When translating from a CIS/2 file to an IFC file, there is also a loss of some of the semantic meaning 

from the CIS/2 file.  This is most common for CIS/2 detailed models.  For example, in CIS/2, a group of 

bolts is parametrically defined by their pattern or layout in an assembly and copes are parametrically 

defined by their dimensions and position on a part.  However, in IFC there is no corresponding parametric 

definition of bolt patterns or copes.  SteelVis generates the correct IFC geometry for bolts and copes, 

however, their parametric definition is lost in the translation.  Many of these differences are described in 

the NIST research for mapping CIS/2 to IFC described above. 

 

The two most important options for generating an IFC file are: (1) how geometry is represented in the IFC 

file (see Shape Representation in section 9.1 below) and (2) how elements are represented in the IFC file 

as beams, columns, and other structural members (see Element Representation in section 9.2 below). 

 

 
Figure 59: IFC file generation options 

 

The main options to generate an IFC file are found in Figure 59.  All of the IFC options are enabled when 

“Generate an IFC file from the CIS/2 file” is selected.  The first option is to select the version of the IFC 
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schema.  Version 2x3 is the current version of the IFC schema and should be selected as it is supported by 

almost all IFC applications and BIM software. 

 

An IFC file is generated when either of the Translate buttons is used (section 3.4 above).  If the IFC 

options are changed, the IFC file cannot be updated without translating the CIS/2 file.  Warning and error 

messages about generating the IFC file are highlighted in light blue in the Status tab (section 3.3.1 above). 

9.1 Shape Representation 

Shape representation refers to how geometric shapes are represented in an IFC file.  The distinction is 

between what the part is versus how the shape of the part is modeled.  For example, in CIS/2 a part is 

defined by a cross section (i.e. W14X120) and length (i.e. 3.048 meters), however, the geometric 

representation of the part is not specified.   

 

IFC takes a different approach.  All parts must explicitly define how the geometry of the part is generated.  

Two methods are used in IFC to model geometry: (1) by modeling all of the surfaces of a part or (2) by 

extruding a section along a path.  The following describes the methods for Shape Representation in the 

IFC options tab. 

 

 Faceted Boundary Representation (B-rep) – geometry is modeled by all of surfaces (facets) on 

the outer boundary of a part 

o Surfaces are defined by their edges which are defined as a line between two points. 

o For example, a straight part with a rectangular cross section will be modeled as six 

surfaces, twelve edges, and eight points. 

o All straight parts can be modeled with this method. 

o All copes (cutouts) can be modeled with this method. 

o Curved parts, bent plates, and corrugated deck are not modeled by SteelVis with this 

method, see section 9.1.1 below. 

 

 Extruded Arbitrary Profiles – geometry is modeled by extruding an arbitrarily shaped section 

profile along a path 

o An arbitrary profile is defined by the points and edges that define the outline of a cross 

section. 

o For example, the profile for a rectangular cross section is defined by four points and the 

edges between them. 

o Ignoring the leg slope and fillet radius, the profile for an angle is defined by six points 

and the edges between them. 

o The path along which the profile is extruded can be straight or curved. 

o Only miter cuts can be modeled with this method, all other copes (cutouts) are not 

modeled. 

o Supported by the IFC Coordination View [18]. 

 

 Extruded Parametric Profiles – geometry is modeled by extruding a parametrically defined 

section profile along a path 

o A parametric profile defines the dimensions of a cross section by its depth, width, and 

thickness. 

o For example, an I-shaped cross section is defined by its depth, width, flange thickness, 

and web thickness. 

o Parametric profiles include: I-shape, T-shape, angle, channel, zee, circular, rectangular, 

hollow, and centerline sections. 
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o Centerline section profiles can be used to model bent plates, corrugated decking, and 

cold-formed steel. 

o The path along which the profile is extruded can be straight or curved. 

o Only miter cuts can be modeled with this method, all other copes (cutouts) are not 

modeled. 

o Supported by the IFC Coordination View [18]. 

 

9.1.1 Shape Representation Limitations 
 

The most significant limitation regarding shape representations is that SteelVis cannot represent curved 

parts, bent plates, and corrugated decking as a faceted boundary representation.  Those types of parts will 

always be modeled as an extruded parametric profile.  For any type of shape representation only the top 

and bottom chords of a joist are written to the IFC file.   

 

Another limitation is that curved parts, bent plates, corrugated decking, mirrored sections, double angles, 

and joists, modeled as extruded parametric profiles might not be supported by many BIM applications 

that import IFC files.  Applications that do not correctly import those types of parts will display them 

incorrectly or not at all. 

 

To test if a BIM application can successfully import any type of structural member modeled with any of 

the methods described above, use the three cis2ifc_test*.stp sample CIS/2 files (section 2.2 above).  

Compare the appearance of the resulting VRML model with the appearance of the IFC file in the BIM 

application or IFC viewer to see if a particular shape representation is supported.   

9.2 Element Representation 

In a CIS/2 file, the function of a part (i.e. beam, column, brace, etc.) can be defined by an optional text 

string.  There is no requirement that the text string be used or what type of information is in the text 

string. 

 

Again, IFC takes a different approach.  Any part in an IFC file must be explicitly defined as a beam, 

column, or other type of structural member.  The options for element representation provide a variety of 

methods to assign parts in a CIS/2 file to IfcBeam, IfcColumn, or IfcMember IFC entities.  The IFC 

documentation [19] provides the following definitions for those entities: 

 

 IfcBeam – “An IfcBeam is a horizontal, or nearly horizontal, structural member. It represents 

such a member from an architectural point of view. It is not required to be load bearing.” 

 IfcColumn – “An IfcColumn is a vertical structural member which often is aligned with a 

structural grid intersection. It represents a vertical or nearly vertical, structural member from an 

architectural point of view. It is not required to be load bearing.” 

 IfcMember – “An IfcMember is a structural member designed to carry loads between or beyond 

points of support. It is not required to be load bearing. The location of the member (being 

horizontal, vertical or sloped) is not relevant to its definition (contrary to IfcBeam and 

IfcColumn).” 
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The IFC element representation options are shown in Figure 59 above.  The assignment of CIS/2 

structural members to the different IFC element representations is based on the orientation (horizontal, 

vertical, other) of that member or assembly: 

 

 IfcBeam/Column – IfcColumn is used for all vertical structural members, everything else is an 

IfcBeam. 

o For detailed models, the assignment of IfcBeam or IfcColumn is based on the orientation 

of the assembly and not the part.  Therefore for a horizontal beam assembly, all parts 

would be IfcBeam, including angle brackets at the end of the beam whose longitudinal 

axis is vertical and could be considered an IfcColumn based on their orientation. 

 IfcBeam/Column/Member – IfcColumn is used for all vertical structural members, IfcBeam is 

used for all horizontal structural members, and IfcMember is used for all other structural 

members such as diagonal bracing. 

o For detailed models, the assignment of IfcBeam, IfcColumn, or IfcMember is based on 

the orientation of the assembly and not the part as described above. 

 IfcColumn/Member - IfcColumn is used for all approximately vertical structural members and 9.1 

 IfcMember – Everything is an IfcMember. 

 IfcBuildingElementProxy – Everything is an IfcBuildingElementProxy element. 

o This can be used with IFC applications that do not support IfcMember. 

 IfcPlate – If plates can be identified in the CIS/2 file, then IfcPlate is used for those members. 

o IfcPlate might not be supported by all IFC applications. 

 IfcRailing – If railings can be identified in the CIS/2 file, then IfcRailing is used for those 

members. 

o IfcRailing might not be supported by all IFC applications. 

 IfcMember for non-main parts - If non-main members can be identified in the CIS/2 file, then 

IfcMember is used for those parts (section 6.1.4 above). 

 

The option for “Use Mapped Representation” is a method in an IFC file to reuse common parts.  This 

reduces the size of the IFC file and the amount of processing by an IFC application.   
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Figure 60: Structure colored by IFC type (element representation) 

 

Figure 60 shows a structure colored using the Color by IFC options (section 4.1 above) using the options 

for element representation shown in Figure 59.  The Color by IFC option is useful to see the effect of 

using any of the IFC element representation options. 

9.3 Units 

The length units used in the IFC file can be either the same units as the CIS/2 file or all of the length units 

can be converted to millimeters.  Converting all units to millimeters is useful when the CIS/2 file contains 

multiple length units such as feet and inches. 

9.4 Stories 

IFC has the concept that structural members can be associated with a building story (floor), however, 

CIS/2 does not.  Therefore all structural members will be contained in one story if stories are generated.  

The only exception is CIS/2 files generated by RAM Steel that use a text string to identify which story a 

member is located on.   

9.5 Displaying the IFC File 

After an IFC file is generated from a CIS/2 file, the IFC file can be displayed automatically in many BIM 

applications and IFC viewers by selecting the “Display IFC file” option as shown in Figure 59 above.  

The list of options that appears in the drop-down menu contains BIM applications and IFC viewers that 

are either installed in their default location, i.e. C:\Program Files, or have a shortcut to them on the 

desktop.  At a minimum, the drop-down menu list will contain the WordPad text editor and a program to 

“Indent IFC File”.  This program is similar to the option for indenting CIS/2 files (section 8.2 and Figure 

54 above).   
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Many of the viewers and applications that can appear in the drop-down menu are listed in the Websites 

menu under IFC Viewers and Applications.  For some viewers and applications in the drop-down menu, 

the user has to manually import the IFC file.   

 

The “Add App” button can be used to add other applications to the drop-down menu list.  The “Display 

Again” button is similar to the “Display Again” button for VRML files (section 3.4 above).  The IFC file 

can be displayed in different IFC applications or viewers in the drop-down menu without having to 

regenerate the IFC file.  Information about displaying the IFC file in Google SketchUp can be found in 

the Help menu. 

9.6 More IFC Options 

Figure 61 shows more options related to generating an IFC file in the More IFC tab.  Some of the options 

are useful to explore different ways to map CIS/2 information to an IFC file. 

 

9.6.1 Analysis Model 
 

If the CIS/2 file contains an analysis model (section 6.2 above), then an IFC structural analysis model can 

be generated.  The structural analysis model can also contain loads and reactions.  Some types of CIS/2 

analysis model loads are not written to the IFC file.  The IFC structural analysis model is only supported 

by a few IFC applications and viewers.  The physical representation of the analysis elements can also be 

generated from the CIS/2 analysis model and is usually more useful to import to BIM applications. 

 

9.6.2 Assemblies 
 

By default, CIS/2 assemblies are written to the IFC file as an IfcElementAssembly which might not be 

supported in some IFC applications.  The other options for IfcGroup and None are enabled only when the 

IFC file is generated for an older version of the IFC schema. 

 

 
Figure 61: More IFC file generation options 
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9.6.3 Bolts, Welds, and Holes 
 

Bolts can be written to the IFC file only if bolts are translated in the CIS/2 file (section 6.1.2 above) and a 

bolt representation of either IfcMember or IfcMechanicalFastener is selected.  IfcMechanicalFastener 

might not be supported in some IFC applications.  The shape of the bolt can be represented as either: (1) 

only the shank of the bolt, (2) the head and shank of the bolt as separate shapes, or (3) the head and shank 

of the bolt combined into one shape using constructive solid geometry (CSG).  The bolt pattern or layout 

is not written to the IFC file although groups of bolts are related together through 

IfcBuildingElementProxy. 

 

Since the number of bolts is frequently much larger than the number of parts in a structure, it is not 

recommended to include the bolts in the IFC file.  Although many IFC applications will display bolts, 

they might not be mapped to the application’s internal representation of bolts. 

 

Welds can be written to the IFC file only if bolts and welds are translated in the CIS/2 file (section 6.1.2 

above) and bolts are written to the IFC file.  It is not possible to write only welds to the IFC file without 

bolts.  IfcFastener is used to represent welds.  The weld path is drawn as a line.  Most IFC applications do 

not support importing welds. 

 

Holes and openings are not written to the IFC file. 

 

9.6.4 Property Sets 
 

Property sets are a mechanism to extend the information in an IFC file with applications specific values.  

Options are available to generate property sets related to section profiles, copes, and coatings.  The profile 

property set contains the section name and cardinal point.  The copes (cutouts) property set contains 

parametric values that define copes (section 6.1.1 above).  The coating property set contains information 

about surface treatments.  The name attribute used on IfcPropertySet is SteelVis_*, where * is the name 

of the type of property.  Property sets defined in the IFC schema such as Pset_BeamCommon are not 

generated. 

 

9.6.5 Cardinal Point 
 

The cardinal point defines where the longitudinal axis of a part is located relative to the cross section 

profile.  Locating a section profile for the top-of-steel is done with a cardinal point.  There is no cardinal 

point in IFC2x3 although the correct geometry accounting for the cardinal point is written to the IFC file.  

The geometric offset of the cardinal point can either be associated with the extrusion of the part or the 

offset of the profile.  All IFC applications correctly display the geometric offset modeled with the 

extrusion option and most with the profile option.  The visual appearance of the IFC file should appear 

the same for either option.  The profile property set contains information about the cardinal point. 

9.7 Globally Unique ID 

All building elements in an IFC file have a Globally Unique ID (GUID) assigned to them.  The GUID 

provides a way to uniquely identify a building element and provides the potential to track a building 

element across multiple software applications.  A GUID is a 32 character string, however, IFC files use a 

compressed version of the GUID that is 22 characters long.  The use of a GUID in a CIS/2 file is optional.  

If the GUID is used, then the entity managed_data_item will appear in the list of translated entities.  If 

possible, the CIS/2 GUID is used as the GUID on the appropriate IFC entity.  The 32 character CIS/2 

GUID is converted to the 22 character IFC GUID.   
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10 Command-line Version 
 

Two versions of the command-line (console) version of SteelVis are available (section 2.1 above).  

ctv.exe runs on any Windows computer and ctv-64.exe only runs on 64-bit computers.  The 64-bit 

version is useful for CIS/2 files greater than approximately 200 MB and should be run on a computer with 

more than 2 GB of memory.  The 64-bit command-line version has the same functionality as the other 

command-line version except that IFC files cannot be generated. 

 

Either command-line version can be run from a Windows command prompt by going to the Windows 

start menu, selecting Run, and entering “cmd”.  This will open up the command prompt window.  To run 

either version, change to the directory where the programs are located and enter either ctv or ctv-64 

and the name of the CIS/2 file to translate.  Entering the name of the program without a CIS/2 file will 

display all of the command-line options as partially shown in Figure 62. 

 

To facilitate running the command-line version, the PATH environment variable can be set to include the 

directory where the command-line executables are located.  A batch file can also be created to run the 

command-line executables.  If the CIS/2 file is not located in the same directory as the command-line 

executable, then the CIS/2 file name should also include the directory pathname for the file.     

 

Most options that are available in the GUI version of SteelVis are also available in the command-line 

version.  However, some options in the command-line version are combinations of individual options in 

the GUI version.  For example, the command-line option “bhw” turns on bolts, holes, and welds. 

 

As an example, the following command:  ctv file.stp sum pop1 bhw web will translate the CIS/2 

file with text popups (section 5.3.1 above), the summary report (section 5.1 above), bolts, holes, and 

welds (section 6.1.2 above) and the resulting VRML model will be displayed in the default web browser. 

 

When the command-line version is run, feedback is provided that is similar to what is displayed in the 

Status tab (section 3.3 above) as shown in Figure 63. 

 

The command-line version can also be embedded or accessed by other programs.  For example, the 

command-line version of SteelVis has been embedded in several commercial software products including, 

FabSuite [20], StruWalker Plus [21], and ConstructSim to facilitate importing and visualizing CIS/2 files. 

 

11 Web Services Version 
 

The online web services version of SteelVis can be accessed at http://ciks.cbt.nist.gov/cgi-bin/ctv/ctv.cgi 

or through the Websites menu of the GUI version [22].  The web services version can be run on a 

computer with any operating system or web browser.  Only a limited set of display options are available 

in the web services version as shown in Figure 64.  IFC files cannot be generated from the web services 

version. 

 

To run the web services version, use the Browse button to select a CIS/2 file on the computer.  Then 

select the appropriate display options.  Finally, use the Translate to VRML button to generate the VRML 

file.  When the CIS/2 file is translated, it is uploaded to a server at NIST where it is processed by SteelVis 

and the resulting VRML file is sent back to the web browser where it can be displayed as either a text file 

or in the web browser VRML plugin.   

 

http://ciks.cbt.nist.gov/cgi-bin/ctv/ctv.cgi
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Figure 62: Command-line version options (partial list) 
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Figure 63: Feedback when running the command-line version 
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Figure 64: SteelVis web services version 

 

 

  



 

 62 

12 References 
 

(All websites were successfully accessed in January 2012). 

 

[1] Crowley, A., Watson, A., “CIMsteel Integration Standards Release 2”, SCI-P-268, The Steel 

Construction Institute, Berkshire, England, (2000), http://www.aisc.org/store/p-2021-cimsteel-

integration-standards-release-2-complete-set.aspx.  

[2] Eastman, C., Wang, F., You S.-J., and Yang, D., “Deployment of an AEC industry sector product 

model”, Computer-Aided Design, Vol. 37-12, October 2005, 1214-1228, 

http://dx.doi.org/10.1016/j.cad.2004.11.007. 

[3] A. Ames, D. Nadeau, and J. Moreland,VRML 2.0 Sourcebook, John Wiley & Sons, Inc., New York 

(1997). 

[4] VRML97 and Related Specifications, Web3D Consortium, 

http://www.web3d.org/x3d/specifications/vrml/. 

[5] IFC Specifications, http://buildingsmart-tech.org/specifications/ifc-overview/ifc-overview-summary. 

[6] buildingSMART, http://buildingsmart.com/. 

[7] Harmonization for CIS/2 and IFC, http://tempest.arch.gatech.edu/~aisc/cisifc/. 

[8] X3D, H-Anim, and VRML97 Specifications, Web3D Consortium, 

http://www.web3d.org/x3d/specifications/. 

[9] X3DOM, http://www.x3dom.org/. 

[10] IFC Quick Browser, http://www.team-solutions.de/?page_id=19. 

[11] IFCsvr, http://tech.groups.yahoo.com/group/ifcsvr-users/. 

[12] Lipman, R.R., “Developing Coverage Analysis for IFC Files”, Proceedings of the CIB W78 

Conference, Cairo, Egypt, November 2010, http://www.nist.gov/manuscript-publication-

search.cfm?pub_id=906055. 

[13] IFC File Analyzer, http://www.nist.gov/el/msid/infotest/ifc-file-analyzer.cfm.        

[14] Express Engine, http://exp-engine.sourceforge.net/. 

[15] NIST Expresso, http://www.nist.gov/el/msid/scl.cfm.  

[16] Lipman, R.R., “Mapping Between the CIMsteel Integration Standards and Industry Foundation 

Classes Product Data Models for Structural Steel”, Proceedings of the International Conference on 

Computing in Civil and Building Engineering, Montreal, Canada, June 2006, 

http://www.nist.gov/manuscript-publication-search.cfm?pub_id=100936.  

[17] Lipman, R.R., “Details of the Mapping Between the CIS/2 and IFC Product Data Models for 

Structural Steel”, Journal of Information Technology in Construction, Vol 14, 1-50, (2009), 

http://www.nist.gov/manuscript-publication-search.cfm?pub_id=861673.  

[18] IFC Coordination View Version 2.0 Summary, http://buildingsmart-tech.org/specifications/ifc-view-

definition/coordination-view-v2.0/summary.  

[19] IFC2x3 Final Documentation, http://buildingsmart-tech.org/ifc/IFC2x3/TC1/html/index.htm. 

[20] FabSuite, http://www.youtube.com/user/FabSuite#p/u/3/I659bZsXdHA.  

[21] StruWalker Plus, http://www.youtube.com/user/AceCadSoftware#p/u/10/EEtDTUVl9PA.  

[22] Lipman, R.R., Reed, K.A., “Visualization of Structural Steel Product Models”, Journal of 

Information Technology in Construction, Vol 8, 51-64, (2003), http://www.nist.gov/manuscript-

publication-search.cfm?pub_id=860885.    

http://www.aisc.org/store/p-2021-cimsteel-integration-standards-release-2-complete-set.aspx
http://www.aisc.org/store/p-2021-cimsteel-integration-standards-release-2-complete-set.aspx
http://dx.doi.org/10.1016/j.cad.2004.11.007
http://www.web3d.org/x3d/specifications/vrml/
http://buildingsmart-tech.org/specifications/ifc-overview/ifc-overview-summary
http://buildingsmart.com/
http://tempest.arch.gatech.edu/~aisc/cisifc/
http://www.web3d.org/x3d/specifications/
http://www.x3dom.org/
http://www.team-solutions.de/?page_id=19
http://tech.groups.yahoo.com/group/ifcsvr-users/
http://www.nist.gov/manuscript-publication-search.cfm?pub_id=906055
http://www.nist.gov/manuscript-publication-search.cfm?pub_id=906055
http://www.nist.gov/el/msid/infotest/ifc-file-analyzer.cfm
http://exp-engine.sourceforge.net/
http://www.nist.gov/el/msid/scl.cfm
http://www.nist.gov/manuscript-publication-search.cfm?pub_id=100936
http://www.nist.gov/manuscript-publication-search.cfm?pub_id=861673
http://buildingsmart-tech.org/specifications/ifc-view-definition/coordination-view-v2.0/summary
http://buildingsmart-tech.org/specifications/ifc-view-definition/coordination-view-v2.0/summary
http://buildingsmart-tech.org/ifc/IFC2x3/TC1/html/index.htm
http://www.youtube.com/user/FabSuite#p/u/3/I659bZsXdHA
http://www.youtube.com/user/AceCadSoftware#p/u/10/EEtDTUVl9PA
http://www.nist.gov/manuscript-publication-search.cfm?pub_id=860885
http://www.nist.gov/manuscript-publication-search.cfm?pub_id=860885

	SteelVis User’s Guide
	1 Introduction
	2 Getting Started
	2.1 Installing SteelVis
	2.2 Running SteelVis
	2.3 Installing a VRML Plugin
	1.1
	1.1
	1.1
	2.4 Translating a CIS/2 File
	2.5 Viewing the VRML Model
	2.6 Uninstalling SteelVis

	3 User Interface
	3.1 Menu Bar
	3.1.1 File Menu
	3.1.2 Browsers Menu
	3.1.3 Websites Menu
	3.1.4 Help Menu

	3.2 Tabs Bar
	3.3 Status Tab (Feedback)
	3.3.1 Error and Warning Messages
	3.3.2 Processing of Sections
	3.3.2.1 Section Types


	3.4 Translate Buttons

	4 Visual Appearance
	4.1 Color Options
	4.1.1 Background Color

	4.2 Rendering Options
	4.3 Title, Ground Plane, Origin Axes
	4.4 Viewpoints
	4.4.1 User-Defined Viewpoints


	5 Text Reports
	5.1 Summary Report
	5.1.1 Part List
	5.1.2 Material List
	5.1.3 Assembly List
	5.1.4 Bolt List

	5.2 Weight in Text Reports
	5.3 Text Popups
	5.3.1 Text Popup in a Tooltip
	5.3.2 Text Popup in the VRML Browser

	5.4 Member Labels

	6 Model Specific Features
	6.1 Detailed Model
	6.1.1 Copes, Camber
	6.1.2 Bolts, Holes, and Welds
	6.1.3 Sequences
	6.1.4 Excluding Parts
	6.1.5 Assemblies

	6.2 Analysis Model
	6.2.1 Nodes and Wireframe

	6.3 Design Model
	6.3.1 Design Connections
	6.3.2 Design Joint System


	7 Other Features
	7.1 Grid Lines
	7.2 Vertical Axis
	7.3 Model Types
	7.4 Curved Parts
	7.5 Navigation Mode
	7.6 Merging Models
	7.7 X3D and X3DOM
	7.8 Simple VRML
	7.9 VRML PROTOs

	8 Debugging Features
	8.1 Coordinate Axes
	8.2 CIS/2 File Checking
	8.3 Generate Excel Spreadsheet
	8.4 File Validation

	9 Generating an IFC File
	9.1 Shape Representation
	9.1.1 Shape Representation Limitations

	9.2 Element Representation
	9.3 Units
	9.4 Stories
	9.5 Displaying the IFC File
	9.6 More IFC Options
	9.6.1 Analysis Model
	9.6.2 Assemblies
	9.6.3 Bolts, Welds, and Holes
	9.6.4 Property Sets
	9.6.5 Cardinal Point

	9.7 Globally Unique ID

	10 Command-line Version
	11 Web Services Version
	12 References

